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2Manipulating Documents
This chapter presents information about Informed documents and how they are manipulated.
learn about Informed document types and password security, as well as how to create, open
and save data documents.

Informed Documents
The term document refers to a file that contains information. An Informed document is a file tha
contains information about a form. There are four types of Informed documents: form templa
documents, form data documents, package documents, and interchange documents.

Form Template Documents (.ITP)

A form template document contains a form template. A form template is the layout or framewo
a form that’s created using Informed Designer. It contains all the intelligent features of the fo
well as its graphic elements. You fill out a form by entering values in the blanks—or cells— o
template. In order to use templates with Informed Filler, you must place them in a folder nam
“Template” (Windows) or “Templates” (Mac OS) in your Informed folder. See Chapter 1, 
“Overview” for more information.

Form Data Documents (.IFM)

A form data document contains only a form’s data. When you fill out forms with Informed Fille
the information entered is stored in a form data document. You can store one completed form
record—in each data document, or you can store many records in a single data document an
advantage of Informed Filler’s built-in database capabilities. To open and manipulate a data d
ment, you must have the appropriate template in your templates folder. A data document is th
common format to use when sending forms to other users.

Package Documents (.IPK)

A package document combines a form template and its associated data in a single file. It is c
using Informed Filler and is used primarily when you mail a form to someone who doesn’t hav
corresponding template. When Informed Filler opens a package, the data document and temp
needed) are extracted. If your templates folder does not already contain the template, the on
extracted from the package is copied there and opened. The data document is opened into a
tled form window.

Informed Interchange Documents (.IIF)

Informed Interchange documents contain all the data for one or more completed forms (or records), 
and are used primarily for transferring information between different applications, and differe

Informed Documents
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versions of Informed. They are created and read using Informed Filler, and store all types of 
mation including stylized text values, pictures, signatures, and annotations.

Other Interchange Documents

In addition to the Informed Interchange documents, Informed Filler can import and export for
data stored in other standard formats, including tab-delimited and comma-delimited text. The
mats are used primarily for transferring form data between Informed Filler and other applicat

The Templates Folder
Although you don’t create and manipulate form template documents like you do form data do
ments, template documents are necessary to the use of Informed Filler. Whenever you creat
data document, you’re asked to select a template to use. When you open a data document (t
document that contains only form data), Informed Filler automatically locates and opens the 
priate template document.

For these reasons, it is necessary that Informed Filler know where to find the templates that 
use. By default, Informed Filler finds your templates in a folder named “Template” (Windows)
“Templates” (Mac OS) located in your Informed folder. You can change this location using 
Informed Filler’s Preferences command. For information about moving your templates folder
“Moving Folders” in Chapter 1, “Overview.”

Template Information
Whenever you create a new data document or open an existing data document, the appropri
plate is opened and used as a means to present and manipulate the form data. Detailed info
about the current template is available by choosing Template Information... from the View menu.
The Template Information dialog box appears.

The Templates Folder

Template Information
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The ‘Template name’ might offer a more descriptive title compared to the filename of the tem
document. ‘Unique template ID’ and ‘Revision number’ are intended to identify the template a
its version. Since templates and data documents are separate files, the template ID is stored
each data document so that Informed Filler can automatically identify and open the appropri
template when a data document is opened.

The Name and Organization information identify the person who created the form template. 
form designer can also provide a brief description of the template.

Licensing Options
Unlike many software products, Shana offers flexible options for licensing Informed Filler. You
license Informed Filler for use will all types of forms, or form designers can license individual f
templates for use with the free version of Informed Filler. Information about licensing and reg
ing Informed Filler can be found in your Informed Filler Getting Started Guide.

Depending on the licensing details of your copy of Informed Filler and the form templates you
you may be restricted to use only certain form templates. If you attempt to use the free versio
Informed Filler with a template not licensed for this use, you’ll see a message indicating so.

Licensing Options
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Creating a New Data Document
The data for the forms that you fill out is stored in data documents (see “Informed Document
lier in this chapter for a detailed description of data documents). To create a new untitled dat
ument, choose New Document... from the File menu. The New Data Document dialog box 
appears.

The New Data Document dialog box shows a list of all templates in your templates folder. To 
a template, click it in the scrolling list, then click ‘New,’ or simply double-click it in the list. The
templates can be organized hierarchically in folders within the templates folder. To open a fo
select it in the list and click ‘Open’ or simply double-click the folder.

To select a template that is not in your templates folder, click ‘Add Other Template.’ The stan
Open dialog appears, allowing you to select a template anywhere on any accessible volume
disks. Informed Filler then copies and places the selected template in your templates folder.

You can also access distribution centers to obtain new templates using controls on the New 
Document dialog. For more information, see “Obtaining a New Template” later in this chapte

Once you’ve located the template you would like to use, select it and click ‘New.’ A new untitl
data document for that template is created and displayed in a form window. A blank record is 
and any cells configured with default or calculated values are filled in automatically.

Creating a New Data Document
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Changing the Password
Each data document can have a password. Passwords allow you to protect your data docum
preventing other users from opening and changing them with Informed Filler. If a data docum
has a non-blank password, you will be prompted to enter it when you attempt to open the doc
using Informed Filler’s Open command (see “Opening a Data Document”).

You can change the password for a data document using Informed Filler’s Preferences comm

Choose Preferences... from the Edit menu. When the Preferences dialog box appears, click th
Security icon in the scrolling list. The dialog box changes to show the Security preferences p

Click the ‘Set Password’ button. The Set Password dialog box appears.

Changing the Password
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If you haven’t entered a password before, only the ‘New password’ and ‘Confirm password’ te
boxes are available. If a password already exists, the ‘Old password’ text box is also availabl

If no password exists, type your new password in the ‘New password’ text box, then press Ta
insertion point moves to the ‘Confirm password’ text box. Type the password again, then clic
‘OK.’ Informed Filler will display a message confirming that you have successfully changed th
password.

If a password already exists, you must enter that password in the ‘Old password’ text box be
entering the new password.

Opening a Data Document
To open a data document, choose Open... from the File menu. The standard Open dialog appear
allowing you to select a data document to open. If you’re using a Windows compatible compu
you’ll see a dialog box similar to the one below.

Select a data document, then click ‘OK.’

If you’re using a Mac OS compatible computer, you’ll see a dialog box similar to the one sho
below.

Opening a Data Document
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Select a data document, then click ‘Open.’

If the data document has a password, you’ll be asked to enter it.

Informed Filler will not open the data document unless the correct password has been entere

For information about changing your password, see “Changing the Password” earlier in this 
ter.

When you open a data document, Informed Filler first examines the document’s Template ID
Template ID identifies which template is needed for displaying and manipulating the contents
the data document. Informed Filler looks in your templates folder for a template with the sam
Template ID as that in the data document. If found, the data document is opened along with 
template and displayed in a form window.

If your templates folder does not contain the needed template, Informed Filler might attempt 
obtain one automatically from a distribution center in your organization. Chapter 14, “Form T
plate Distribution,” describes Informed Filler’s built-in forms distribution features. If the form 
designer has made the needed template available in one or more distribution centers, and if 

Note Passwords are case sensitive. This means that upper and lower case letters are considere
different. Be sure that the Caps Lock key on your keyboard is not on when you enter your p
word.
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tribution information is available in the data document that you’re attempting to open, Informe
Filler will display this message:

This message indicates that the template you need is available from an accessible distributio
ter. If you click ‘OK,’ Informed Filler will place a copy of the template in your templates folder,
then continue to open it along with the data document.

If your templates folder does not contain the needed template, and the template is not availa
from a distribution center, you’ll see a message asking if you’d like to look for the template yo
self.

If you have the appropriate template located at a different place on your hard disk, you can lo
and select it by clicking ‘OK’ on the message dialog. To cancel the Open command, click ‘Ca
instead.

You locate and select a template using the standard Windows or Mac OS Open dialog box. W
you select the correct template, Informed Filler copies it to your templates folder and then op
along with the data document.

Opening a Locked Data Document

If you choose to open a locked data document, or a data document that resides on a locked 
volume, Informed Filler will warn you.
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If you continue, the data document will be opened as usual. However, you won’t be able to sa
changes made. To save any changes, use the Save As command to save the data documen
with any changes made, into a new file. For more information about the Save As command, 
“Saving Copies of a Data Document” later in this chapter.

Opening a Data Document in Use

You cannot open a data document that is already open for use by another user or application
attempt to do so, a warning message will appear.

If you click ‘OK,’ another dialog box appears telling you that Informed Filler is waiting for the d
document to become available. When the document becomes available, Informed Filler will o
automatically. To cancel the Open command instead, click ‘Cancel.’

Opening a Package
As explained earlier (see “Informed Documents”), a package document contains both a form
document and a form template document together in a single file. The purpose of package d
ments is to be able to save, mail, or transfer completed forms—or records—along with the a
priate form template in a single document.

If a person sends you a form using e-mail, and is unsure whether or not you have the require
template, he or she might send you a package document instead of a data document. That w
will be able to open the form even if you don’t have the required template.

When you open a package document, Informed Filler automatically extracts the form data an
necessary, form template document. If your templates folder already contains a template wit
Template ID that matches the one in the data document in the package, then that template is
That is, the template in the package document is not extracted. If your templates folder does
contain the necessary template, Informed Filler will extract the template from the package, c
to your templates folder, then open it along with the data document.

Unlike data documents, when Informed Filler opens a package document, it does not open t
ument in place. That is, once you’ve opened the package and made changes to the data, sav
changes will not update the original data document in the package. Instead, Informed Filler w

Opening a Package
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save the data in a new data document, just as though you were saving a new untitled data do
You’ll be asked to name the data document and specify its location the way you normally do.

Duplicate Template IDs
It is important that each of the templates in your templates folder have a unique template ID. 
templates have the same template ID, Informed Filler will not know which template to use wh
you open a data document or package with the same template ID.

If Informed Filler detects two or more templates with the same template ID, it will select and 
one of them and mark the others as duplicates. Once a duplicate template has been marked
appear with a small warning sign on Informed Filler’s New Data Document dialog box.

The warning sign is an indication that you should resolve the duplicate templates. That is, yo
should choose the template that you want to use and remove the duplicates.

Missing Fonts
When you open a template (as a result of opening a form data or package document, or crea
new data document), Informed Filler checks to make sure that the fonts used on the templat
available in your system. Different systems on different computers can have different fonts 
installed. If a template is drawn on one computer, then transferred to different computer, that
puter might not have the fonts that were originally used to draw the template.

If Informed Filler detects that at least one font is missing from your system, you’ll see the follo
dialog box.

Duplicate Template IDs

Missing Fonts
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Any text that uses an unavailable font will display using a font that’s available in your system

Closing a Data Document
The Close command closes the currently active data document—that is, the document which
sponds to the front-most form window on your screen.

To close the currently active data document, choose Close from the File menu, or click the win-
dow’s close box. Depending on the kind of document that you’re working with, and the work 
has been done, one of the following situations will arise.

Closing a New Data Document

If you’re closing a new data document that has not been changed, the document is closed im
ately. If you’re closing a new document to which changes have been made, Informed Filler w
warn you to save the changes.

If you’re using a Mac OS compatible computer, the button names on this dialog box will be d
ent. Instead of ‘Yes’, you’ll see ‘Save’, and instead of ‘No’, you’ll see ‘Don’t Save.’ Clicking the
‘Yes’/‘Save’ button displays the Save dialog box. If you’re using a Windows compatible comp
you’ll see the standard Windows Save dialog box.

Closing a Data Document
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Type the name of the new data document and select a location to store it, then click ‘OK.’

If you’re using a Mac OS compatible computer, you’ll see the standard Mac OS Save dialog 

Type the name of the new data document and select the location to store it, then click ‘Save.
ing ‘Cancel’ instead cancels the Close command and leaves your data document open.

If a document with the name you specify already exists at the selected location, Informed Fille
warn you with options to replace the existing document or to cancel.

Clicking ‘No’/‘Don’t Save’ closes the data document without saving any of the work you’ve do
Clicking ‘Cancel’ cancels the Close command and leaves your data document open for editin

Closing an Existing Data Document

When you close an existing data document (that is, a document that was previously opened)
Informed Filler first checks to see if you’ve made changes to the document. If your data docu
has not changed since you last opened it, then it’s closed immediately without warning.

If you’ve made changes to the document, you’ll be asked if you want to save the changes.
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If you’re using a Windows compatible computer, the button names on this dialog box will be d
ent. Instead of ‘Save’, you’ll see ‘Yes’, and instead of ‘Don’t Save’, you’ll see ‘No.’ Click ‘Yes’/
‘Save’ to save the changes and close the data document. Click ‘No’/‘Don’t Save’ to discard th
changes and close the document. Click ‘Cancel’ to cancel the Close command and continue 
your document.

Saving a Data Document
The Save command saves the currently active data document—that is, the document that co
sponds to the front-most form window on your screen. This command is available only when
changes have been made to the currently active data document.

To save a data document, choose Save from the File menu. If the data document corresponds to
existing document (that is, it has been saved at least once before), it will be saved without w

If you’re saving a new data document for the first time, you’ll be asked to name the documen
specify the location to store it. Depending on which operating system you’re using, you’ll see e
the standard Windows Save dialog box or the standard Mac OS Save dialog box.

Type the name of the new data document and select the location to store it, then click ‘OK.’ C
ing ‘Cancel’ instead cancels the Save command.

Saving Copies of a Data Document
Use the Save As command to save a copy of a data document with a different name, or at a d
location. You can also use the Save As command to create a package document containing b
active data document and its accompanying template.

Choose Save As... from the File menu. If you’re using a Windows compatible computer, you’ll s
the standard Windows Save dialog box.

Saving a Data Document

Saving Copies of a Data Document
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If you’re using a Mac OS compatible computer, you’ll see the following dialog box.

When saving a new data document using the Save As command, you can choose to include
rent record only, the currently collected records, or all records. Make your selection from the 
‘Include’ drop-down list.

You can save a new data document or a new package document. If you’re using a Windows c
ible computer, you make your choice from the ‘Save File as Type’ drop-down list. If you’re usi
Mac OS compatible computer, leave the ‘Make package (include template)’ option unchecke
save a data document. If you check the ‘Make package (include template)’ option, Informed 
will create a package document instead.
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After saving a new data document, Informed Filler will leave the new document open for edit
and close the original document. If you save a new package document, however, the origina
document will remain open instead.

Collecting Data Documents
If you’re responsible for approving forms, you’ll likely receive forms one at a time from other p
ple for approval purposes. If you want to retain a copy of these forms, you might want to colle
them into a single data document. That way you can sort the forms, list them on the Record 
and use Informed Filler’s other database features.

Informed Filler allows you to import the data from one data document into another. You can d
using Informed Filler’s Import command. If you use a Mac OS compatible computer, you can
a data document onto the form window that corresponds to the data document you want to c
into. For detailed information about Informed Filler’s Import command, see “Importing Record
in Chapter 13, “Exchanging Information.”

Updating a Data Document
As explained earlier (see “Opening a Data Document” and “Opening a Package”), Informed 
automatically locates and opens the appropriate form template when you open a data docum
Whenever Informed Filler opens a form template (as a result of opening a data or package d
ment), it automatically checks to make sure that the data matches the template.

If the template has changed since the last time you opened the data or package document, o
you’ve received a data or package document from someone else who has a different version
template, Informed Filler might notice differences between the data and the template. For exa
the template might contain a new cell for which there is no data in the data document. Or ma
cell’s type has changed.

If differences are detected, Informed Filler will update the data to match the template. The tim
is takes to update the data depends on the particular differences and the number of records 
data document. You’ll see a progress dialog box during the update process.

Obtaining a New Template
Chapter 14, “Form Template Distribution,” describes Informed’s built-in forms distribution fea-
tures. After designing a new form template, the form designer can make the template availab
one or more distribution centers. Different types of distribution centers are supported, includin
servers and FTP servers.

Collecting Data Documents

Updating a Data Document

Obtaining a New Template
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Obtaining a new template from a distribution center is an easy process. As explained earlier 
“Opening a Data Document,” it can be as simple as clicking ‘Yes’ on a message dialog. Inform
Filler does the rest for you.

The most common method of obtaining a new distributed template is by means of Informed F
New Data Document dialog box. This dialog box appears when you choose the New Docum
command from Informed Filler’s File menu.

When you choose the New Document command, Informed Filler, by default, shows you the t
plates that are found in your templates folder. The last item in the drop-down list above the scr
list is ‘Services.’ When you select this item, the list changes to show the distribution centers t
correspond to the distribution center profiles found in your distribution centers folder (named 
TCTRS” on Windows, “Distribution Centers” on the Mac OS). A distribution center profile is a 
containing the information necessary to identify and connect to a distribution center. See Ch
14 for more information about distribution center profiles.

To display the templates available at a particular distribution center, select its name in the lis
click ‘Open.’ The scrolling list changes to show the available templates. Templates might be o
nized in folders. To open a folder, select it in the list and click ‘Open,’ or simply double-click th
folder itself. Once you’ve located the template that you want, select it in the list then click ‘Ne
Informed Filler copies the distributed template to your templates folder and opens it, creating 
untitled data document.

Once you’ve obtained a new template from a distribution center, Informed Filler will automatic
notify you when a new version of the template is available. For detailed information about ho
revision checking works, and the various commands and preferences associated with templa
tribution, please see Chapter 14, “Form Template Distribution.”
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